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Uso previsto

ClinicalExpress se emplea para transmitir imagenes DICOM desde un
digitalizador de iméagenes médicas a un proveedor de clase de impresion 0 a un
proveedor de clase de almacenamiento DICOM. Esta dirigido a usuarios que
desean utilizar un digitalizador de radiografias médicas para digitalizar
radiografias analdgicas o transmisivas en una estacién de trabajo DICOM
mediante telerradiologia tradicional, asi como a usuarios que quieren obtener
duplicados de radiografias impresas usando tecnologia digital en protocolos
postscript y DICOM.
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Acerca de este manual 6

Acerca de este manual

Este manual proporciona instrucciones detalladas para instalar y utilizar
ClinicalExpress®. EI manual esta organizado en los siguientes temas:

m Acerca de ClinicalExpress describe ClinicalExpress como parte de un
sistema DICOM para radiografia 0 mamografia tipico.

m Instalacion de ClinicalExpress repasa los requisitos del sistema 'y
proporciona instrucciones para la instalacion del software.

Nota: consulte la informacion relativa a la conectividad en la
declaracion de conformidad DICOM, un documento aparte.

m Configuracién de ClinicalExpress explica como configurar los sistemas
de captura y transmision de radiografias de ClinicalExpress, asi como otros
temas de interés para los administradores de sistemas ClinicalExpress.

Nota: las instrucciones de funcionamiento figuran en otro
manual, la “Guia del usuario de ClinicalExpress”.

Convenciones utilizadas en este manual

m Las teclas especiales que el usuario tiene que pulsar en el teclado se indican en
LETRAS VERSALITAS. Por ejemplo, si en el texto aparece la palabra ENTRAR, hay
que pulsar la tecla correspondiente del teclado.

m Los nombres y los comandos de los menUs se indican en letras mayusculas.
Por ejemplo, el mend Archivo (File) incluye el comando Instalar licencia
(Install License). En este manual, los comandos se expresan en una notacion
abreviada. Por ejemplo, Archivo > Salir (File > Exit) significa seleccionar el
comando Salir (Exit) del menu Archivo (File).

m Los nombres de las ventanas, botones, cuadros de dialogo y otros elementos
que aparecen en la pantalla se indican en negrita. Por ejemplo, la ventana
Inicio de sesién de ClinicalExpress (ClinicalExpress Login) (a
continuacion) contiene los campos Nombre de usuario (User Name) y
Contrasefa (Password), asi como los botones Aceptar (OK) y Cancelar

(Cancel).

Clinical Express Login
Uger Mames: j
Pagsword: |
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Acerca de ClinicalExpress®

ClinicalExpress 6.0 es un programa para Windows que permite digitalizar
radiografias y transmitir iméagenes radiogréficas. El programa incorpora los
modos de Radiografia general y Mamografia, y se puede adquirir solo para
Radiografia general, solo para Mamografia o para ambos modos.

Digitalizacion. Usando como dispositivo de entrada un digitalizador de
radiografias VIDAR, ClinicalExpress presenta imagenes radiograficas y las
asocia con un determinado paciente y estudio. EI programa ofrece una serie de
controles para examinar las imagenes a efectos de control de calidad y ajustar sus
caracteristicas.

Indicaciones de uso. Las imagenes de radiologia general digitalizadas con
ClinicalExpress cumplen o superan el estdindar DICOM o el del ACR relativos al
uso de imagenes de captura secundaria con fines de consulta, revision e
interpretacion final.

Las iméagenes mamogréficas digitalizadas con ClinicalExpress como iméagenes
DICOM MG deben usarse Unicamente como referencia o con fines de
comparacion, no para el diagnostico principal.

Opciones
Las siguientes opciones se pueden adquirir por separado:

Lista de trabajo de modalidad (Modality Work List o MWL)). Esta opcion
permite a las modalidades de adquisicion de imagenes descargar informacion
de listas de trabajo de procedimientos programados y datos relacionados,
presentar dicha informacién al operador de la modalidad y garantizar que las
imagenes DICOM contienen datos descriptivos coherentes. En este manual se
explica como usar la lista de trabajo de modalidad en ClinicalExpress. Los
detalles de la integracion figuran en la declaracion de conformidad DICOM.

PDI. Esta opcidn incluye las funciones de Medios de Importacion/Exportacion
DICOM (para leer y grabar CD DICOM), Digitalizacién plana en papel y
Consulta de pacientes (para buscar informacion de pacientes en dispositivos
de almacenamiento).

19752-001 Rev. B
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Acerca de ClinicalExpress 8

Descripcidon general del sistema

La estacion de trabajo de captura y transmision de radiografias ClinicalExpress
normalmente consta de lo siguiente:

m Digitalizador de radiografias VIDAR para crear imagenes digitales a partir
de radiografias.

m Ordenador con Windows® XP 32 bits o Windows 7 32 0 64 bits y el
programa ClinicalExpress instalado.

Notas

m La estacion de trabajo ClinicalExpress NO es una estacion
de trabajo para diagnéstico. Para fines de diagndstico, use
una estacion de trabajo adecuada (consulte las instrucciones
de la guia de instalacion y funcionamiento de la estacion de
diagndéstico).

m Las imagenes mamograficas digitalizadas con
ClinicalExpress deben usarse Unicamente como referencia y
con fines de revisién, no para el diagnéstico principal.

Modo de radiografia general

Para transmitir imagenes, la estacion de trabajo utiliza una conexion de datos que
envia los datos de imagen a una estacion de trabajo o sistema remotos. Para hacer
copias, la estacion de trabajo se conecta a una impresora de radiografias 0 a un
dispositivo de salida no radiogréafico. Como dispositivo de entrada de datos
también se puede utilizar un escaner de documentos opcional.

Radiograiia Estacion de

original trabajo remota

Datos de .
-
. s
——
. Dalos de

Impresora
de radiografias

impresora ! l

Estacion de ClinicalExpress tipica

Copia de radiografla

19752-001 Rev. B Guia del administrador de ClinicalExpress 6.1



Acerca de ClinicalExpress 9

Modo de mamografia

Para transmitir imagenes, la estacion de trabajo utiliza una conexion de datos que
envia los datos de imagen a una estacién de trabajo o sistema remotos.

Radiografia
original

——— Datos de
= imagen

'
'
'
'
'
'
'
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'
'
'
' -
1 —
'
'
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'
'
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Datos de
imagen

Q Conexisn )
onexion :

Estacion de ClinicalExpress tipica

Estacién de
trabajo remota
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Acerca de ClinicalExpress 10

Qué se puede hacer con ClinicalExpress

ClinicalExpress 6.0 funciona como un centro de control para la captura,
transmisién y copia de radiografias. El programa permite:

m Digitalizar.

Designar un paciente y un estudio, o crear un nuevo historial de paciente

0 estudio.

Usar la opcién de Lista de trabajo de modalidad (disponible por separado)
para obtener informacion de los pacientes desde un origen externo (en
lugar de introducir los datos del paciente con el teclado).

Configurar los parametros de digitalizacion basicos: la resolucion y la
profundidad en bits.

Digitalizar una o més radiografias.

Comprobar la calidad de la imagen creada a partir de la radiografia antes
de enviarla o copiarla.

Modificar la imagen: ajustar la ventana y el nivel, girar, voltear, invertir los
tonos, dividir imagenes, ampliar una region de interés, aumentar la escala y
redactar informacion confidencial.

m  Transmitir.

Seleccionar una estacion de trabajo o sistema remoto (el “destino”).
Enviar imégenes digitalizadas al destino seleccionado.
Digitalizar y enviar en una sola operacion.

m Copiar (solo en el modo de radiografia general).

Seleccionar una impresora (si hay varias impresoras conectadas al sistema).
Especificar el nimero de copias que se quieren hacer de cada radiografia
original.

Iniciar la impresion.

Combinar maltiples imagenes en una radiografia.

Digitalizar e imprimir en una sola operacion.

m Importar y exportar a CD compatibles con el estandar DICOM.

Las licencias se otorgan dependiendo de las caracteristicas y funciones que
incluya ClinicalExpress. Todas las licencias incluyen la funcion de digitalizacion
y las funciones DICOM de Envio (envio a proveedores de clase de servicio
DICOM, estaciones de trabajo/PACS) y Copia (impresion en impresoras DICOM
o dispositivos postscript). Ademas, se pueden adquirir licencias para las
siguientes opciones:

m Lista de trabajo de modalidad.

m PDI. Grabacion de CD desde un visor DICOM a Medios de exportacion,
Medios de Importacion/Exportacion, Consulta de pacientes y Escaner de
documentos en papel.

Nuevas funciones de ClinicalExpress 6.1

m Nuevas opciones de formato de fecha.

m Soporte para etiquetas de mamografia DICOM Derivadas/Primarias a efectos
de compatibilidad con los sitios de GE.

m Soporte para la adquisicion de fechas para etiquetas de mamografia a efectos
de compatibilidad con los sitios de Siemens.

19752-001 Rev. B
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11

Instalacion de ClinicalExpress®

Requisitos del sistema

Para digitalizar y transmitir imagenes usando ClinicalExpress® es necesario
disponer de un sistema informatico, un digitalizador de radiografias VIDAR y
una conexion de red.

Ordenador

El sistema informéatico minimo para Windows XP 32 bits SP3 es:

m PC Pentium 4 a 3.0 GHz

m 2 GB de memoria (para series grandes de imagenes de alta resolucion, como
es el caso de la mamografia, hace falta mas memoria)

m 50 GB de espacio disponible en el disco duro

El sistema informéatico minimo para Windows 7 Professional de 32 y 64 bits es:

m PC Dual Core 2a 1.8 GHz

m 4 GB de memoria (para series grandes de imagenes de alta resolucion, como
es el caso de la mamografia, hace falta mas memoria)

m 50 GB de espacio disponible en el disco duro

Video para todos los ordenadores:

m Tarjeta de video con 16 MB de memoria, con una resolucién de 1280 x 1024 y
64.000 colores o una profundidad de color mayor

m Pantalla de 20 pulgadas con una resolucién de 1280 x 1024

Digitalizador de radiografias
ClinicalExpress funciona con la mayoria de los digitalizadores de radiografias

médicas VIDAR. Contacte con Medtech enviando un correo a
medtech@vidar.com para saber si su digitalizador es compatible.

ClinicalExpress no funciona con digitalizadores de radiografias de otros
fabricantes.

Conexién de red

Son adecuadas, entre otras, las conexiones de red LAN, WAN, inalambricas y
diversos servicios telefonicos. Para que funcione correctamente hace falta el
protocolo TCP/IP. La explicacion detallada de la conexion de red no se
contempla en el ambito de este manual.

19752-001 Rev. B
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Instalacién de ClinicalExpress 12

Escaner de documentos opcional

Se puede afiadir al sistema un escéner de documentos USB. ClinicalExpress
funciona con la mayoria de los controladores TWAIN. Para usar un escaner de
documentos opcional, éste se debe adquirir aparte. Contacte con el Servicio
Técnico de VIDAR (véase mas adelante) para obtener una lista de los escaneres
probados con el sistema.

Escenarios de instalacion

Repase los escenarios que figuran a continuacion para determinar su situacion
actual y como conviene llevar a cabo la instalacion de ClinicalExpress 6.0.

m Sies la primera vez que instala ClinicalExpress:
1. Ejecute el archivo ClinicalExpress6.x..exe del CD de ClinicalExpress.

2. El software funcionard en modo de evaluacién durante 30 dias. Para
continuar usando el software después de los 30 dias, hace falta una clave de
licencia (véase “Obtener una clave de licencia para ClinicalExpress” mas
adelante en este mismo capitulo).

m Si hay instalada una version anterior de ClinicalExpress:

e Sila version instalada es la 4.x o anterior, contacte con el Servicio Técnico
de VIDAR (véase méas adelante) para obtener las instrucciones de
actualizacion.

e Si tiene instalada la version 5.0 o superior, puede instalar ClinicalExpress
6.0 sin necesidad de desinstalar la version anterior.

Contacte con el Servicio Técnico de VIDAR si tiene cualquier
duda sobre la instalacion del software ClinicalExpress:

Teléfono: +1 800 471 SCAN (+1 800 471 7226)
+1 703 471 7070 fuera de EE. UU.
Correo electrénico: medtech@vidar.com

19752-001 Rev. B Guia del administrador de ClinicalExpress 6.1
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Descripcion general de la instalacion

Nota: para poder instalar ClinicalExpress y realizar funciones
administrativas debe iniciar una sesion como Administrador. Los
usuarios pueden tener, pero no requieren, derechos administrativos
en el PC.. Para obtener instrucciones se puede consultar:
m El tema “Cémo afiadir un miembro a un grupo” de la Ayuda
y Centro de Asistencia de Windows XP.
m Los temas “Crear una nueva cuenta de usuario” y “Modificar una
cuenta de usuario” del archivo de ayuda de la ventana
Administracién de equipos de Windows.

La instalacion consta de cinco pasos generales:

A. Instalar y configurar el digitalizador de radiografias.
B. Ajustar la pantalla.

C. Instalar el software ClinicalExpress.

D. Ejecutar ClinicalExpress.

E. Obtener una clave de licencia de ClinicalExpress.

En los siguientes apartados se explica cada uno de ellos de forma detallada.

Sugerencia: si esta creando una nueva estacién de trabajo,
no instale todos los componentes al mismo tiempo. En lugar
de ello, instale primero el digitalizador de radiografias
(siguiendo las instrucciones facilitadas con el digitalizador).
Seguidamente ajuste la pantalla (paso B). Finalmente, instale
el software ClinicalExpress (paso C) y asegurese de que el
sistema funciona.

A. Instalar y configurar el digitalizador de radiografias

Instale y configure el digitalizador de radiografias y su software siguiendo las
instrucciones facilitadas con el digitalizador (los detalles de este paso no se
contemplan en el &mbito de este manual).

Nota: en la seccion de Atencion al cliente del sitio web
(www.filmdigitizer.com) se pueden descargar las guias de
instalacién y funcionamiento del digitalizador de radiografias
VIDAR. También puede solicitar los manuales llamando al
+1 800 471 7226 (+1 703 471 7070 fuera de EE. UU.).

19752-001 Rev. B Guia del administrador de ClinicalExpress 6.1
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B. Ajustar la pantalla

1. Haga clic con el boton derecho en el escritorio y seleccione Propiedades en
el mend emergente.

Arrange [cons By ¥
Refresh

Paste Shorkcut

Properties

Nota: puede que en su sistema haya un comando especifico
del adaptador de video que sustituya al comando Propiedades.
Si fuera el caso, haga clic en ese comando. El didlogo de las
propiedades de pantalla puede ser diferente, pero el objetivo

es el mismo: ajustar la resolucién de la pantalla a un valor igual
0 superior a 1280 x 1024 y la profundidad del color a 16 bits

0 mas.

2. En la ventana Propiedades de pantalla, seleccione la pestafia
Configuracion.

Display Properties

TthBSlDesktnp Screen Sawver | Appearance || Settings

A theme iz a backaground plus a set of sounds, icons, and other elements
to help you perzonalize your computer with one click.

Thermne:

iy Current Theme [Modified) w |

Sample:

19752-001 Rev. B Guia del administrador de ClinicalExpress 6.1



Instalacién de ClinicalExpress 15

3. Ajuste el Area de pantalla (o la Resolucion de pantalla) a 1280 x 1024
0 mas, y los Colores (o la Calidad del color) a Color de alta densidad
(16 bits) o0 més.

Display Properties

Dizplay:
SynchMaster 214T [Analog) on NYIDIA GeForcez Mx/wx= 400
Screen rezolution Color quality
Less P Mo Highest (32 bif v|
1500 by 1200 pisels 1 N BN  m
[ Troublezhont. .. ] [ Advanced ]
I 0k l [ Cancel l Apply

4. Pulse Aceptar.

19752-001 Rev. B Guia del administrador de ClinicalExpress 6.1



Instalacién de ClinicalExpress 16

C. Instalar el software ClinicalExpress

Nota: si va a actualizar ClinicalExpress 4.x 0 una version
anterior, contacte con el Servicio Técnico de VIDAR enviando
un correo a medtech@vidar.com para obtener instrucciones.

Nota: ClinicalExpress se puede instalar en el sistema sin el
digitalizador de radiografias. Sin embargo, el programa no
funciona si no hay un digitalizador de radiografias conectado,
encendido y en comunicacion con el ordenador.

1. Inserte el CD de ClinicalExpress en la unidad de CD del ordenador.

2. En Windows Explorer, acceda a la unidad de CD y haga doble clic en

ClinicalExpress6.x..exe.

3. Siga las instrucciones de la ventana del instalador.

Durante la instalacion se le pedira que seleccione la GUI predeterminada
(Radiografia general o Mamografia) que aparece al ejecutar ClinicalExpress.
Seleccione la GUI méas adecuada para su organizacion (esta opcion se puede
cambiar en la pagina Administracion > Local (Administration > Local) de
ClinicalExpress).

4. Una vez finalizada la instalacién, saque el CD-ROM de la unidad de CD-

ROM. (En el paso E le haré falta la clave que figura en la etiqueta del CD.)

Incorporacidn de un escaner plano de papel

Se puede instalar un escéner plano de papel para usarlo con ClinicalExpress.
Siga las instrucciones de instalacion del fabricante del escaner. VIDAR ha
comprobado que los escaneres USB 2.0 normales con controladores TWAIN son
compatibles con ClinicalExpress.

Nota: en la estacion de trabajo de ClinicalExpress solo debe
instalarse el controlador TWAIN del escaner plano. La
presencia de cualquier otro controlador TWAIN puede interferir
con el funcionamiento de ClinicalExpress. Contacte con el
Servicio Técnico de VIDAR enviando un correo a
medtech@vidar.com para obtener una lista de los escaneres
gue se han probado.

19752-001 Rev. B
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D. Iniciar ClinicalExpress

Nota: ClinicalExpress funcionara durante 30 dia sin una clave
de licencia. Para continuar usando ClinicalExpress pasado este
tiempo, contacte con VIDAR Systems Corporation para obtener
una clave de licencia (en el siguiente apartado se dan
instrucciones al respecto).

1. Haga doble clic en el icono de ClinicalExpress del escritorio.
0
Inicio > Todos los programas > ClinicalExpress.

2. Se abre la ventana Sesién de usuario (User Login):

Clinical Express Login

Uzer Mame: ﬂ

Password: |

] 8 Cancel |

3. Use el nombre y la contrasefia predeterminados del administrador:
a. Deje el Nombre de usuario (User Name) como Admin.
b. Deje la Contrasefia (Password) en blanco.
c. Pulse Aceptar (OK).

4. Si el digitalizador esta encendido y correctamente conectado, aparece el
mensaje siguiente. Pulse Aceptar (OK).

x|

& The product is running in evaluation mode. There are 30 days
§/ remaining. Contact VIDAR at https://esales.vidar.com to get a
= valid license.

OK |

5. Se ejecuta ClinicalExpress.

Nota: no se pueden digitalizar radiografias mientras no se haya
definido al menos un destino valido. Consulte el siguiente
capitulo de este manual: “Configuracion de ClinicalExpress”.
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E. Obtener una clave de licencia de ClinicalExpress

Nota: no se puede obtener una clave de licencia enviando por
fax el contrato de licencia de ClinicalExpress. Para obtener una
clave de licencia por correo electrénico, hay que seguir las
instrucciones que figuran en este apartado.

Para obtener una clave licencia tiene que hacer lo siguiente:

1. Genere un codigo de referencia y envielo a VIDAR:

Nota: el cédigo de referencia solo se puede generar si el
ordenador con ClinicalExpress esta conectado a un digitalizador
de radiografias VIDAR.

a. En la ventana principal de ClinicalExpress, seleccione Archivo > Generar
codigo de referencia (File > Generate Reference Code).

b. En el cuadro de didlogo Generar codigo de referencia (Generate
Reference Code):
m Introduzca o modifique los campos Nombre de usuario (User Name),
Empresa (Company) y Pais (Country).
m Introduzca la Clave de CD (CD Key) impresa en la etiqueta del CD de
instalacion de ClinicalExpress.

Generate Reference Code ll

User Name: I

Compary: I

Country: I

CD Key: I

Generate Reference Code

Please enter the required information and dick the Generate Reference Code button to
generate the Reference Code.

SavE opy Tio Cliphaard Close
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c. Pulse el botdn Generar codigo de referencia (Generate Reference

Code).
x|
User Name: I <yoUr USer name s
Company: I <WOUF COMpany' Narne =
Country: I your country >
CD Key: I{cd ke =

| Generate Reference Code I

Reference Code has been successfully generated.

Please select Copy to Clipboard and follow instructions at hitps: /fesales. vidar.com for
immediate anline licensing or Save the Reference Code to a file and then email the file

to mailto:medtech@vidar.com to get a license key.
Note: The Reference code is valid only for 14 days.

Save | Copy To Clipboard | Close |

Nota: el cédigo de referencia es vélido durante 15 dias.

. Pulse el botén Guardar (Save) para guardar el codigo de referencia en un

archivo en el disco duro local. Guarde el archivo en una ubicacién que sea
facil de recordar.

. Pulse el boton Cerrar (Close).

Cree un mensaje de correo electrénico nuevo.

. En el campo Para del mensaje, escriba medtech@vidar .com.

. A continuacion:

m Localice el archivo (tiene la extension .ref) guardado en el paso d
anterior y adjuntelo al mensaje.

Envie el mensaje.

Nota: mientras espera a que llegue la clave de licencia, puede
usar ClinicalExpress en el modo de evaluacion sin necesidad
de una clave durante 30 dias. Durante el periodo de evaluacion
de 30 dias, todas las funciones estan habilitadas.
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2. Cuando haya recibido por correo electrénico la clave de licencia de VIDAR:

a. Guarde el archivo adjunto (con la extension .key) en el escritorio.

b. Inicie una sesion de ClinicalExpress como administrador.

c. En la ventana principal de ClinicalExpress, seleccione Archivo > Instalar

licencia (File > Install License).

Install License x|

| Paste From Clipboard I Load From File

Reference Code:

=

-
4 b

Register

d. En el cuadro del didlogo Instalar licencia (Install License):

m Pulse el botdn Cargar desde archivo (Load From File), localice el

archivo de la clave de licencia (con la extension

Install License ll

.key) y abralo.

Paste From Clipboard | | Load From File

Reference Code:

Z6rWRrghPPTSOI34QT fag6WrJbmICSi0 /Sg6uBDE 1sTkpg/SkRmlvBeizl

Register

<LicKey> <Date>5/30/2011 2:37:12 PM</Date> <ID>ad8b1ct9-f2E;|

>
| | »

e. Pulse el botén Registrar (Register).
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f. Siel programa acepta la clave de licencia, se abre la ventana que figura a
continuacion. Pulse Aceptar (OK).

ClinicalExpress x|

Please relaunch your application for the features with the new
l Y license to take effect completely.

General Radiology
Print
Send

g. Archivo > Salir (File > Exit).

h. Vuelva a ejecutar ClinicalExpress haciendo doble clic en el icono de
ClinicalExpress del escritorio.

i. Para comprobar la licencia: Ayuda > Acerca de (Help > About). La
licencia debe aparecer en la parte superior de la pagina. Si tiene la licencia
para Radiografia general y para Mamografia, debe comprobar que aparezca
en ambas aplicaciones.

3. Vaya al apartado “Configuracion de ClinicalExpress”, a continuacion en este
manual, para configurar el programa.
0
Si necesita configurar ClinicalExpress para imprimir, repase las instrucciones
de configuracién de las impresoras validadas para ClinicalExpress en el
directorio Printer Specific del CD de instalacién de ClinicalExpress.
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Configuracion de
ClinicalExpress®

En este capitulo se describen las tareas administrativas que se pueden realizar en
ClinicalExpress:

m Inicio de sesion en la ventana Administracion (Administration).
m Configuracion de los parametros de la estacién de trabajo local.

m Configuracion de los pardmetros de presentacion.

m Configuracidn de las resoluciones del digitalizador.

m Configuracion de las opciones de procesamiento de imégenes.

m Definicion de las vistas de mamografia.

m Establecimiento de campos de entrada de datos obligatorios.

m Administracion de las cuentas de usuario.

m Seleccion de los campos de datos para anonimizar.

m Copia de seguridad y restablecimiento de la licencia.

m Definicion de destinos.

m Repaso de la configuracion del digitalizador de radiografias.

m Comprobacion de la disponibilidad de listas de trabajo de modalidad.
m Revision y gestion del archivo de registro.

m Calibracidn del digitalizador de imagenes.

Este capitulo incluye ademas instrucciones basicas para calibrar el monitor de la
estacion de trabajo.

Si es la primera vez que configura ClinicalExpress, conviene que lea todos los
apartados de este capitulo y lleve a cabo todas las operaciones aplicables a la
configuracion de su sistema y a las funciones con licencia de ClinicalExpress.

Nota: para poder acceder a la ventana Administracién
(Administration) de ClinicalExpress y efectuar modificaciones,
debe iniciar una sesién como administrador.

Nota: no se pueden digitalizar radiografias mientras no se haya
definido al menos un destino valido. Consulte el apartado
“Definicion de destinos” méas adelante en este capitulo.
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Inicio de sesidn en la ventana de Administracion

La ventana Administracion (Administration) de ClinicalExpress esta protegida
por contrasefia.

1. Opciones > Administraciéon (Options > Administration).

Si ya ha iniciado una sesion en ClinicalExpress como administrador, vera la
ventana de Administracion (Administration) y puede ir directamente al paso
2. En caso contrario, vera la ventana de inicio de sesion:

Clinical Express Login Ayuda: el nombre

predeterminado es Admin

User Name: | ] (se distinguen mayusculas y
mindsculas) y la contrasefia se
Password: | deja en blanco de forma
predeterminada (deje el

0k Cancel | campo vacio).

2. Introduzca la Contrasefia (Password) del administrador y pulse Aceptar
(OK).
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Configuracion de los parametros de la estacidon de trabajo

local

dlﬂ Local
' - Digplay Settings

- Digitizer Settings
- Image Proceszing
. Mammography
- Mandatary Fields
- Uzer Manager
e ROz E

.. License Backup
- Targets
- Filrn Drigitizer

Ajuste los parametros de la estacion de trabajo local en la rama Local del arbol
de Administracion (Administration).

Gy Administration JB

x|

— DICOM Parameters

Station Mame:

IEIinicaIEHpress

F.eep Log Entries

|1 0 VI daylz]

AE Title: ICIinicaIEHpress
Port Mumber; |2EI?'
Manufacturer Model Narne: IVidar Digitizer
—Log Localization
Log Level: |INFDF|M.&TIDN Vl Language: IEninsh[US]

Date Format:

— Syshem

Finimum Digk Space;
tawiniuni Film Length:
Transmizsion B etries:
Fietry Time:

Ligts' Start Field:
Imagesz Path:

™ Lock Keps

[ Enable Additional Patient's Histary

™ &uto Generate Accession Number

{100 ME

|17 inchas
{0

|30 mirute(s]

=

IF'atient I ame:

IE: YProgramD atahyidars ClinicalE spresshD atahlmages

™ Send Empy Accession Number
™ Send Film Size 1D

[ Send each Image as a Series

™ Setimage Type as
DERIVEDSFRIMARY

— Auto Logout

Timne: |'-_' hovirs]

— Diefault Startup GLUI

¢ General Hadiography

IU_ mitiute(z]

| Mammography

— Delete After Send
[~ Patient

r—Auta Fill Study
[~ Date

[ Images

[ Time

— Delete After Storage Commitment

[~ Patient

[ Images

Apply |

Cloze
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Parametros DICOM

DICOM Parameters

Station Mame: |CIinica|E:<press
AE Tithe: |CIinica|E:<press
Port Mumber: |2D?
Manufacturer Model Mame: |\-"idar Digitizer

El Titulo de entidad de aplicacién (EA) es el nombre que utilizan otras
aplicaciones de software para identificar esta aplicacion.

1. Introduzca el Titulo de entidad de aplicacién para este dispositivo DICOM (el
valor predeterminado de este campo es “ClinicalExpress™). En el Titulo EA se
distingue entre mayusculas y minusculas.

2. Introduzca el Namero de puerto (Port Number) para este dispositivo
DICOM (el valor predeterminado de este campo es “207™).

3. Pulse el boton Aplicar (Apply).

Registro
Log
Log Levek [INFORMATION |
Keep Log Entries |'| 0 j daw(s]

1. Cambie la configuracion del registro como corresponda:

m Nivel de registro (Log Level): especifica los tipos de informacion que se
pueden ver en la ventana Registro de errores (Error Log):
e INFORMACION (INFORMATION) muestra la informacién DICOM
y la informacién de ClinicalExpress.
e ADVERTENCIA (WARNING) muestra solamente los errores y las
advertencias.
e ERROR muestra solamente los errores.

ClinicalExpress captura automaticamente todos los errores y la
informacidn. (Para ver el registro de errores completo, abra el archivo
clx.log en un editor de texto.)

Nota: la ventana Registro de errores (Error Log) no es una
herramienta de diagndstico DICOM completa, ya que no
captura transmisiones DICOM completas. Se usa
principalmente para solucionar problemas de software.

m Conservar entradas del registro (Keep Log Entries): las entradas del
archivo del registro se borran al cabo de este nimero de dias. (\Véase
“Revision y gestion del archivo de registro” méas adelante en este capitulo.)

2. Pulse el boton Aplicar (Apply).
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Localizacion

Localization
Language: I Englizh[lJ5] ﬂ
Date Farmat: | MM/DDAYYY [Defaul] =]

1. Seleccione el Idioma (Language) para la interfaz de usuario de la aplicacién.

2. Seleccione el Formato de fecha (Date Format) para la aplicacion.

3. Pulse el boton Aplicar (Apply).

4 Salga de ClinicalExpress y vuelva a ejecutarlo para hacer efectivos los

cambios.

Sistema

r— System

Minimum Dizgk Space:
Mawirnum Film Length:
Transmission B eties:
Rety Time:

Lists' Start Field:
Images Path;

™ Lock Keps

f100 ME

I'I 7 inches
o

|3E| mirke(z]
IF'atient I arme j

IC:'\F'rogramDataWidar\CIinicalE wpreszhDataiimages

™ Send Empty Accession Number

™ Enable Additional Patient's History ™ Send Film Size ID

[ &uto Generate Accession Mumber [ Send each Image az a Series

[ Setlmage Type as
DERMEDAPRIMARY

1. Cambie la configuracién como corresponda (en la imagen superior se indica la
configuracion predeterminada):

m Espacio en disco minimo (Minimum Disk Space): cuando el espacio
disponible en disco desciende por debajo de este valor, ClinicalExpress
borra automéaticamente archivos empezando por los estudios mas antiguos
gue se han enviado correctamente. Si el programa no puede liberar
suficiente espacio para alcanzar el valor de Espacio en disco minimo
(Minimum Disk Space), no permite que el usuario pueda digitalizar
radiografias hasta que haya suficiente espacio disponible.

m Longitud méxima de radiografia (Maximum Film Length):
normalmente se ajusta para radiografias de 43,2 cm de longitud, pero este
valor se puede cambiar para usar radiografias mas largas.
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Nota: no ajuste la Longitud maxima de radiografia (Max Film
Length) a un valor superior a 43,2 cm salvo que tenga
conectado un digitalizador de radiografias DIAGNOSTICPRO®
Plus 0 DIAGNOSTICPRO® Advantage. Consulte las instrucciones
para digitalizar radiografias de més de 43,2 cm de largo en la
guia de funcionamiento del digitalizador correspondiente.

Nota: como el sistema utiliza una rutina de ajuste automatico
del tamafio para determinar la longitud de la pelicula
radiografica, puede que no se puedan digitalizar radiografias
perforadas.

Intentos de transmision (Transmission Retries): especifica el nimero

de veces que ClinicalExpress intentara enviar un estudio a un destino.

ClinicalExpress gestiona las transmisiones de estudios fallidas del siguiente

modo:

e Si hay otros estudios en la cola de transmisién, cualquier estudio que no
se haya podido enviar se coloca al final de la cola y se intenta enviar
mas tarde, sujeto siempre al nimero de intentos de transmision y al
tiempo entre intentos (véase mas adelante).

e Si no hay ningun otro estudio en la cola de transmisién, ClinicalExpress
intenta reenviar el estudio inmediatamente, sujeto siempre al nimero de
intentos de transmisién y al tiempo entre intentos (véase mas adelante).

e Si el estudio no se puede enviar después del nimero especificado de
intentos de transmision, pasa a figurar en la lista de la ventana Estudios
adquiridos (Acquired Studies) (Ver > Estudios adquiridos (View >
Acquired Studies)), desde donde se puede iniciar manualmente la
transmision.

e Un estudio que no se pueda enviar (y en tanto no se consiga hacerlo)
tiene el estado de “fallido”.

Tiempo entre intentos (Retry Time): especifica el tiempo (en minutos)
que ClinicalExpress espera antes de intentar enviar un estudio a un destino
tras fallar el intento previo.

Primer campo de listas (Lists’ Start Field): especifica si la primera
columna de la lista de estudios adquiridos y de la lista de procedimientos
de la lista de trabajo es el Nombre del paciente (Patient Name) o la ID.

Ruta de imagenes (Images Path): si quiere, puede modificar el directorio
local predeterminado en el que se guardan las iméagenes, como por
ejemplo en una particion o una unidad de mayor capacidad. Para cambiar
la ruta, pulse el botén ... y seleccione la nueva ruta.

Bloquear teclas (Lock Keys): si se marca esta opcion, ClinicalExpress
desactiva las teclas (p. ej., ALT-TAB) que permiten al usuario cambiar de
ClinicalExpress a otros programas abiertos.

Habilitar historia adicional (Enable Additional Patient’s History): si se
marca esta opcidn, ClinicalExpress muestra el campo Historia adicional
(Additional Patient History) en la parte inferior de la ventana
Informacion del estudio (Study Information).
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Patient/Sudy/Series Information

Fatient Informastion

Laat Mama: Firnt Mo

Datn/Tima:
MM DD YR HH MM 55 Mealty:
T x

Insbtter Mo

First Namer

Mickde Name:

Coding Scheme Designator Cexe Mearwg

[
MM DD VY Sex

Ay [hese

o

Savins Informstion
Dt Time:
o MM DD VY HH MM 55
~ I Wy
By Pt Enered

Frodccol Mo
Descrption

Prsturrat Prosimd Coske
Cade Ve

Cading Schama Datigrator

Cexo Mearrg

Patient/Study/Series Information

Fatseni Inloimaslion.
-

I

Study Inlomation
0
BT

Actastion busber
Admitrg Diagrosis Descsphon:
Disepor:

Pafermrg Prysican

Lt Masns

Priedhan Coe
Code Viaksn

Dty Tima:
MM DD T HH MM 55 Wedality:

Inttder o
Fent Mpt Mate W

e Scharma Deigratos [ r——

[

it Mo MM DD VY Sex

! ™

Serins Information
[
o MM DD VWYY WM MM 55

Bocy Pt Enameadt
Frotesced Name.

Dreserphon:

Pastormed Prosacol Code
Cade Vs

Cading Schan Desigraler

Code Mearrg

o5 | caen |

Al P Hati /

0 | taed |

Ventana Informacion del paciente/estudio/serie
(Patient/Study/Series Information) sin el campo
Historia adicional (Additional Patient History)

Ventana Informacion del paciente/estudio/serie
(Patient/Study/Series Information) con el campo
Historia adicional (Additional Patient History)

Generacién automatica del namero de registro (Auto Generate
Accession Number): si se marca esta opcion, ClinicalExpress inserta
automaticamente el siguiente nimero de registro secuencial en la ventana
Informacion del estudio (Study Information) cuando el usuario inicia un
nuevo estudio. EI nimero de registro insertado se puede editar.

Enviar nimero de registro vacio (Send Empty Accession Number): si
se marca esta opcion, ClinicalExpress no envia los nimeros de registro a
los destinos.

Enviar ID del tamafio de radiografia (Send Film Size ID): si se marca
esta opcion, ClinicalExpress envia las dimensiones de la radiografia a
los destinos.

Enviar cada imagen como una serie (Send each image as a Series): si se
marca esta opcidn, cada imagen se envia como una serie. Si no se marca,
una serie puede incluir maltiples imagenes.

Configurar tipo de imagen como DERIVADA\PRIMARIA (Set Image
Type as DERIVED\PRIMARY): si se marca esta opcion, las imagenes se
etiquetan para usarse en sistemas de mamografia de GE.

2. Pulse el botdn Aplicar (Apply).

Desconexion automatica (Auto Logout)

™ Auto Logout

Time: o)

l_ minutelz)

Si se marca esta opcion, ClinicalExpress se cierra automaticamente si no detecta
actividad del usuario (teclado o ratén) durante el tiempo indicado.
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Después del cambio, pulse el boton Aplicar (Apply).

Borrar al enviar (Delete After Send)

Delete After Send

™ Patient ™ Images

Si se marca esta opcidn, ClinicalExpress elimina a los pacientes o las iméagenes
unos 10 minutos después de haberlos transferido correctamente al destino.
Consideraciones:

m Cuando estan activadas, estas opciones impiden que el disco de la estacion de
trabajo se sature con archivos de imagen. No obstante, los estudios enviados
inmediatamente después de la adquisicion, y eliminados a continuacion, no
aparecen en la ventana de Estudios adquiridos (Acquired Studies), y por
tanto no pueden enviarse mas tarde al mismo o a cualquier otro destino.

m Si estan desactivadas, estas opciones permiten que los estudios aparezcan en
la ventana de Estudios adquiridos (Acquired Studies), por lo que pueden
enviarse mas tarde a cualquier otro destino. Sin embargo, los estudios se
acumulan en el disco de la estacion de trabajo y pueden eventualmente saturar
su capacidad.

m La base de datos de ClinicalExpress tiene una capacidad méxima de 10 GB. Si
se alcanza este limite, para poder continuar digitalizando radiografias deben
eliminarse imagenes y pacientes.

Después del cambio, pulse el botén Aplicar (Apply).

Borrar tras compromiso de almacenamiento (Delete After
Storage Commitment)

Delete After Starage Carnmitrent

I Patient I Images

Si se marca esta opcion, ClinicalExpress solo elimina a los pacientes o iméagenes
tras recibir el mensaje de compromiso de almacenamiento del destino. El
mensaje confirma no solo que el destino ha recibido la transmision, sino también
que la ha almacenado. (Consultar las consideraciones en el apartado “Borrar al
enviar” anterior.)

Después del cambio, pulse el boton Aplicar (Apply).
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GUI inicial predeterminada (Default Startup GUI)
Default Startup GUI

{* General Fadiography " Mammooraphy

Esta opcion especifica el modo de presentacion al iniciar ClinicalExpress. Si se
han adquirido licencias para Radiografia general y Mamografia, los usuarios
pueden cambiar de un modo a otro.

Después del cambio, pulse el botén Aplicar (Apply).

Autocompletar estudio (Auto Fill Study)
Ao Fill Study

I Date [ Time

Si se marca esta opcidn, se introducen automaticamente la fecha y la hora
actuales en los nuevos estudios.

Después del cambio, pulse el botdn Aplicar (Apply).
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Configuracion de los parametros de presentacion

Ajuste los pardmetros de presentacién en la rama Local | Configuraciones
de presentacion (Local | Display Settings) del arbol de Administracion
(Administration).

X
[=l- Local
- Digitizer Settings Dizplay zettings automatically apply window and level adjustments to an image based
i Image Processing on modality and body part selected by the uzer.
& Mammography
- Mandatory Fields ~ Create, Edit and Delete Display Settings
i Usger Manager . .
" Madality [ Body Part Wiew
; i License Backup
Targets
i Filen Drigitizer
l |
Film Type [ Digitizer Type | & Bit | 12 Bit | 1E Bit | |
lear Film Any Digitizer 174,155 2800, 2495 44510, 39929
lear Filr TeleRadPRO 218,100 3500, 1600 56013, 25606
lear Filr TeleRadPRO Edge 218,100 3500, 1600 56013, 25606
lear Filrm YETRadPRO Edge 218,100 3500, 1600 56013, 25606
e Film Any Digitizer 125, 221 2000, 3550 32007, 5EE13
e Film TeleRadFRO 199,125 3200, 2000 51212, 32007
e Film TeleRadFRO Edge 199,125 3200, 2000 51212, 32007
e Film VETRadFRO Edge 199,125 3200, 2000 51212, 32007
K¥ ]
MHew Edit [Delete
™ Enable suto wWindow/Level

Configuraciones de presentacion preestablecidas

Las configuraciones de presentacion aplican automéaticamente a una imagen los
ajustes de ventana y nivel correspondientes en funcién de la parte del cuerpo y la
modalidad seleccionadas por el usuario. Los ajustes se basan en el tipo de
pelicula radiografica, el tipo de digitalizador y la profundidad en bits. En la
pantalla superior se muestran cuatro configuraciones de presentacion
preestablecidas. Esta seccidon de la ventana Administracion (Administration)
permite definir, modificar y eliminar configuraciones de presentacion.
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m Para crear una nueva configuracion de presentacion:
a. Pulse el botdn Nueva (New).

b. Haga clic en el campo Modalidad (Modality) e introduzca la modalidad.
0
Seleccione una modalidad de la lista.

c. Haga clic en el campo Vista (View) e introduzca la vista.
0
Seleccione una vista de la lista.

d. Introduzca los datos de ventana y nivel de una profundidad en bits.
ClinicalExpress calcula y rellena automéaticamente los valores
correspondientes de las otras dos profundidades en bits.

Create, Edit and Delete Display Settings

td dality Body Fart Wig 3 Bit 12 Bit 16 Bit
DEFAULT DEFAULT DEFAULT 174,155 2800, 2495

Ventana Nivel
Filrn Type: | Digitizer Type | 3 Bit | 12 Bit | 16 Bit
Clear Film Any Digitizer 174,155 2800, 2435 445810, 33929
Clear Film TeleFad PRO Digiziter 218,100 3500, 160 56013, 25606
Ay Digitizer 258, 22 il 56813
Blue Film TeleFad PRO Digiziter 199,125 3200, B0 l 51212, 32007
Ventana Nivel

e. Pulse el botén Guardar (Save).

Nota: ClinicalExpress ha precalculado los ajustes de ventana y
nivel para la Parte del cuerpo (Body Part) =
PREDETERMINADA y la Modalidad (Modality) =
PREDETERMINADA. Estos son los ajustes que se aplican
inicialmente a las imagenes. El usuario los puede reemplazar
usando la herramienta para configurar la ventana y el nivel con
el raton, o bien introduciendo valores en los campos Ventana
(Window) y Nivel (Level) de la ventana principal o usando los
valores de ventana/nivel preestablecidos. El administrador
puede modificar las configuraciones predeterminadas (en la
lista de la izquierda) como se describe a continuacion.
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m Para cambiar los valores de ventana y nivel de una configuracién de
presentacion:

a. Pulse en la fila que desee cambiar.

b. Pulse el botén Editar (Edit).

c. Modifique el valor de la ventana (campo izquierdo) o el nivel (campo
derecho) de una profundidad en bits. ClinicalExpress calcula y rellena
automaticamente los valores correspondientes de las otras dos

profundidades en bits.

d. Pulse el botén Guardar (Save).

m Para eliminar una configuracion de presentacion:
a. Pulse en la fila que desee eliminar.
b. Pulse el botén Eliminar (Delete).
m Para aplicar automéaticamente los ajustes de ventana y nivel en funcion del

tamarfio de la radiografia y de la resolucién de la imagen: marque la casilla
Habilitar ventana/nivel automaticos (Enable Auto Window/Level).
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Configuraciodn de las resoluciones del digitalizador

- Local
. Display Settings
Drigitizer Settings
Image Processing
td armmography

td andatory Fields
|Jzer Manager
Anonymize

: - License Backup
- Tangets

"~ Film Digitizer

o admnstration x|
Default resolution settings autormatically identifies the film width and gets the resalution for digitization based on the
nearest film size of the: film width.
—Set default rezolution for different DICOM standard Film Sizes
DICOM Standard Film Size | Rezolution
1.0”:-:1 210" 4", 24Crmx24Cm, 24Cmax30Cm 150
11147, 1117 150
A3 150
14":14", 14"%17" 150
< | >l
Change Eance

Ajuste las resoluciones del digitalizador en la rama Local | Configuraciones del
digitalizador (Local | Digitizer Settings) del arbol de Administracion
(Administration).

Las configuraciones del digitalizador ajustan automaticamente la resolucién de la
imagen en funcidn del ancho de la pelicula radiografica.

m Para cambiar una resolucion:
a. Pulse en la fila que contiene el tamafio de radiografia que desea modificar.
b. Haga doble clic en la columna Resolucién (Resolution) de esa fila.
c. Seleccidn la resolucién correspondiente.

d. Pulse el boton Guardar (Save).
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Configuracion de las opciones de procesamiento

de imagenes

Ajuste las opciones de procesamiento de imagenes en la rama Local |
Procesamiento de imagenes (Local | Image Processing) del arbol de

Administracion (Administration).

G Administration ]

[=1- Local

B e Dizplay Settings
- Digitizer Settings
# Image Proceszing

i Mammography
-~ Mandatory Fields
i User Manager
S Anonymize
. iolicensze Backup
- Tangets
‘-~ Filrm Digitizer

1 Unszharp Mask

When activated ClinicalE spresz applies the unsharp mask algorithm to sharpen image
detail.

= Loy £ Medium " High

1 DRC [Dynamic Fange Compression]

When activated ClinicalE spresz appliez a nonlinear filker to compress an image's dunamic
rahge.

= Low | Weditm ' High

— Pozt-Digitization Processing

[ Shaighten Image After Digitization

Enter a threzhald value,

8 Bitz Per Pinel: |3 Heset |
12 Bits Per Pizel: IED

16 Bitz Per Pixel: 200

= Monitor LUT

When activated ClinicalE xpresz applies the Look Up T able values to the image before
dizplaying an the monitor

& From File I _‘
 [enerate using |—
Density (0.2-26)  1°
—1 Apply SDF

Wwhen activated ClinicalE =press applies the Standard Display Function values to the image
before dizplaying on the monitor

lllumination: |2EIEII'.I cd! m”2 Dbdin: IIJ

Ambient Light: 10 cd/ m™2 Db aw: 255

Heset |

Appl |

Cloze

Nota: las configuraciones predeterminadas de la ventana
Procesamiento de imagenes (Image Processing) estan
desactivadas.
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Nota: ClinicalExpress aplica de manera automéatica y
permanente a cada imagen las operaciones de procesamiento
de imagenes marcadas en cuanto las adquiere del digitalizador
(y, por consiguiente, antes de presentarlas o enviarlas). Los
usuarios no pueden deshacer los resultados del procesamiento
de imagenes. Si las imagenes no se tienen que procesar, es
necesario que el administrador desactive las opciones de la
pagina Procesamiento de imagenes (Image Processing) y
que el usuario vuelva a digitalizar las radiografias para obtener
nuevas imagenes.

1. Configure las opciones de procesamiento de imagenes como corresponda:

m Mascara de desenfoque (Unsharp Mask): si se marca esta opcién,
ClinicalExpress aplica un algoritmo de mascara de desenfoque para
aumentar la nitidez de la imagen. Seleccione Baja (Low), Media
(Medium) o Alta (High) para controlar el grado de nitidez.

m DRC (compresion de la gama dindmica): si se marca esta opcion,

ClinicalExpress aplica un filtro no lineal para comprimir la gama dindmica

de la imagen. Seleccione Baja (Low), Media (Medium) o Alta (High)
para controlar el grado de compresion.

m Procesamiento posdigitalizacion (Post-Digitization Processing):
e Enderezar imagen tras la digitalizacion (Straighten Image After

Digitization): si se marca esta opcidn, las imagenes que sobrepasan el

Valor umbral (Threshold Value) se enderezan automaticamente

después de la captura. Si no se marca, el usuario puede enderezar las

imagenes en la ventana de ClinicalExpress.

e Valor umbral (Threshold Value): para que se enderece
automaticamente, la rotacion de la imagen debe ser mayor que
este valor.

e Restablecer (Reset): pulse este boton para restablecer los valores
de umbral predeterminados.

Nota: para enderezar automéaticamente las imagenes se asume
gue los bordes de la radiografia son rectos y forman angulos
rectos entre si. Desactive esta opcién si se ha cortado la
radiografia.

m TB de monitor (Monitor LUT): si se marca esta opcion, ClinicalExpress

aplica los valores de la tabla de busqueda a la imagen antes de

representarla.

e Desde archivo (From File): seleccione esta opcién si la tabla de
busqueda esta disponible como un archivo. Introduzca la ruta y el
nombre del archivo o pulse el boton de examinar para seleccionar el
archivo.

e Generar usando la densidad (Generate Using Density): seleccione

esta opcion para que ClinicalExpress genere una tabla de bisqueda
basada en el valor de densidad especificado.
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m Aplicar FVE (Apply SDF): si se marca esta opcion, ClinicalExpress
aplica a la imagen los valores de la funcion de visualizacion estandar antes
de presentarla, y para ello usa los valores de lluminacién (lllumination),
Luz ambiental (Ambient Light), DMin (densidad minima del
digitalizador) y DMax (densidad méxima del digitalizador) especificados.

2. Pulse el botdn Aplicar (Apply).
Valores de FVE DICOM
predeterminados

lluminacion 2000 cd/m?
Luz ambiental 10 cd/m?
DMin 0

DMax 255
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Definicion de las vistas de mamografia

Ex Administration ] x|

[=]- Local

; i Dizplay Settings

- Digitizer Settings

- Image Processing
o b arnroaraphy
- Mandatory Fields
i User Manager
S Anonymize

. o Licensze Backup

- Targets

b Film Diigitizer

Las vistas proporcionan a los usuarios de ClinicalExpress protocolos de clasificacion
para organizar imagenes mamograficas independientes en determinadas
composiciones. ClinicalExpress viene con un protocolo de 2 x 2 predeterminado.

El usuario puede definir otras vistas en funcion de sus necesidades.

Nota: la opcién de escaneado de documentos para
mamografia es una funcién afiadida en ClinicalExpress 6.0. Si
no dispone de la opcién PDI, es necesario afiadirla para poder
escanear documentos con un escaner plano. También es
necesario definir un disefio para trasladar la Vista radiografica

(Film View) a PAPEL (PAPER).

Defina las vistas en la rama Local | Mamografia (Local | Mammography) del
arbol de Administracion (Administration).

— Create, Edit and Delete Mammo Wiew Layouts

—Views
Mame | Layout | Digitization Order
| |
—Wiew Order
L ayaut |2:<2 'l —— = = =
Row | Column | FilmWiew | Patient Orientation |
— Lavout Preview REL. Fostarior Left [P
1 2 LCC Anterior Right [AMA]
2 1 RMLO Pozterior Foot Left [
2 2 LMLO Anterior Foot Right [...
RCC LCC
RMLD LMLOD
< |

Cuztomize | Tew | Edit | [elete |

Mote :  Only the Film Yiew and the Patient Orientation in the Yiew Order can be changed when editing.
For other changes create a new layout.

Cloze
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1. Pulse el boton Nueva (New).

2. En la lista Vistas (Views), haga clic en la columna Nombre (Name),
introduzca un nombre para el disefio y pulse ENTRAR.

Yiews
MHame Lapout Diigitization Qrder
DEFALLT 2x2 RCC | LCC | RMLO | LMLD |
Layaut 1 Ix2 RCC | LCC | RMLO | LMLO | RML | LML |
Layout 2 Tu1 oo
Layout 3 2xd RCC | LCC | RMLO | LMLO | RML | LML | RMLO | LMLO |

Layout 4 203

Lapout 5

RCC | LCC | RMLO

LMLD
LCC | RMLO | LMLO

| RML | LML |

3. Abra la lista Disefio (Layout) y haga clic en el disefio de filas x columnas

correspondiente.

4. En la lista Orden de vistas (View Order), especifique la Vista radiografica
(Film View) de cada celda. La Vista previa del disefio (Layout Preview)
muestra como se asignan las vistas radiograficas a las celdas.

iew Order

Colurn

Film Wi

Fatient Origntation

Anteriorn Right [&4R)
Pogterior Foot Left [..
Anterior Foot Right [

Nota: para escanear documentos, configure la Vista
radiogréfica (Film View) como PAPEL (PAPER).

Nota: la Orientacién del paciente (Patient Orientation) se
ajusta automaticamente al seleccionar una Vista radiogréafica
(Film View), y no se debe modificar.

Nota: los usuarios pueden modificar aqui la Orientacion del
paciente (Patient Orientation) predeterminada.

m Para eliminar una vista:

a. En la lista de Vistas (Views), haga clic en la vista y pulse después el botdn

Eliminar (Delete).

b. Confirme la eliminacién.
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m Para editar una vista:

a. En la lista de Vistas (Views), haga clic en la vista y pulse después el boton
Editar (Edit).

b. En la lista de Vistas (Views), haga clic en el Nombre (Name) e introduzca
un nuevo nombre.

c. Enlalista Orden de vistas (View Order), cambie la Vista radiogréafica
(Film View) y la Orientacion del paciente (Patient Orientation) como
corresponda.

d. Pulse el boton Guardar (Save).

Nota: una vista solo se puede eliminar o modificar si no hay
ningun estudio que haga referencia a ella.

Entender las vistas y las orientaciones del paciente

El siguiente ejemplo muestra las relaciones entre las vistas, las imagenes y las
orientaciones del paciente.

Suponga que se definen las dos vistas siguientes:

Vista A
Fila Columna | Vista Orientacion del
radiografica | paciente
1 1 CCD PC
1 2 CCI AC
2 1 MLOD ACI
2 2 MLOI PCI
Vista B
Fila Columna | Vista Orientacion del
radiografica | paciente
1 1 CCD Cl
1 2 CCl PC
2 1 MLOD PCI
2 2 MLOI CD

A las imégenes dispuestas en las celdas se les asignan las orientaciones del
paciente predeterminadas. Supongamos que se esta usando la Vista A. La imagen
situada en la fila 1 - columna 1 (CCD) tendréa la orientacion PC predeterminada.

Supongamos ahora que el usuario hace clic con el boton derecho en una imagen,
cambia su orientacién a PC y la arrastra hasta la fila 2 - columna 2 (MLOI). Esta
imagen anula la orientacion PCI predeterminada y conserva la orientacion PC
asignada por el usuario.

Imaginemos ahora que el usuario selecciona la Vista B de este mismo estudio.
Esta accidn aplica a las imagenes las orientaciones del paciente predeterminadas
de la Vista B. La imagen correspondiente a CCD, por ejemplo, tiene ahora la
orientacion Cl.
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Supongamos que el usuario cierra el estudio. A continuacion usted (como
administrador) edita la Vista B, y cambia a AC la orientacion del paciente
correspondiente a CCD. Si el estudio se vuelve a abrir, la imagen CCD tiene la
orientacion del paciente Cl (guardada con el estudio al cerrarlo), no AC (la nueva
orientacion predeterminada para la celda CCD). Sin embargo, si se afiade una
nueva imagen a la celda CCD, se le asigna la orientacion AC predeterminada.

Creacion de codigos de vista personalizados y codigos de
modificador de vista personalizados

Se pueden crear cddigos de vista personalizados para incluirlos en la lista
desplegable de la columna Vista radiogréafica (Film View) de la lista Orden de
vistas (View Order) de la rama Local | Mamografia (Local | Mammography)
del &rbol de Administracién (Administration) (descrito anteriormente en esta
seccién). También se pueden crear codigos de modificador de vista
personalizados asociados con los cddigos de vista personalizados.

Nota: cuando se publicé este manual, DICOM e IHE no habian
definido cédigos de vista personalizados ni cédigos de
modificador de vista personalizados. El desarrollo, uso y
fiabilidad de los cadigos de vista personalizados y codigos de
modificador de vista personalizados es responsabilidad
exclusiva del usuario de ClinicalExpress.

m Para crear un cddigo de vista personalizado:

1. Enlarama Local | Mamografia (Local | Mammography) del arbol de
Administracién (Administration), pulse el botén Personalizado
(Custom). Esto abre la ventana Personalizar vistas de mamografia
(Customize Mammography Views) (véase la pagina siguiente).

2. Enla seccion Codigos de vista personalizados (Custom View Codes),
pulse el botdon Nuevo (New).

3. Haga clic en cada columna y rellene la informacion asociada.

4. Pulse Guardar (Save).

m Para editar un codigo de vista personalizado:
1. En la seccién Codigos de vista personalizados (Custom View Codes),
haga clic en el codigo de vista que desee editar.
2. Pulse Editar (Edit).
3. Cambie la informacion que corresponda.
4. Pulse Guardar (Save).

m Para eliminar un cédigo de vista personalizado: haga clic en el codigo de
vista que desee eliminar y pulse Eliminar (Delete).

Nota: un codigo de vista personalizado solo se puede editar o
eliminar si no hay ningun disefio de vista que haga referencia al
mismo.

m Para crear un codigo de modificador de vista personalizado:
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1. En la seccidon Codigo de modificador de vista personalizado (Custom
View Modifier Code), pulse el boton Nuevo (New).

2. Haga clic en cada columna y rellene la informacién asociada.

3. Pulse Guardar (Save).

Para editar un codigo de modificador de vista personalizado:

1. En la seccién Codigos de modificador de vista personalizados (Custom
View Modifier Codes), haga clic en el c6digo de modificador de vista que
desee editar.

2. Pulse Editar (Edit).

3. Cambie la informacién que corresponda.

4. Pulse Guardar (Save).

Para eliminar un codigo de modificador de vista personalizado: haga clic en
el codigo de modificador de vista que desee eliminar y pulse Eliminar
(Delete).

Nota: un codigo de modificador de vista personalizado solo se
puede editar o eliminar si no hay ningun cédigo de vista
personalizado que haga referencia al mismo.

Nota: durante el almacenamiento y la exportacion DICOM, los
cadigos de vista personalizados se afiaden al encabezado de la
imagen DICOM como una secuencia de cédigos de vista (0054,
0222). Todos los cadigos de modificador de vista se envian
como una secuencia de cddigos de modificador de vista (0054,
0220) que es parte de la secuencia de cédigos de vista.

19752-001 Rev. B

Guia del administrador de ClinicalExpress 6.1



Configuracion de ClinicalExpress 43

Customize Mammography Yiews

-~ Cugtom View Codes

| Code¥alue | CodeMeaning | Coding Scheme Designator |

Fatient Orientation

|'iews Madifier Code

MHew |
Fikd Ll
Rl =
RS
D
b
5
SAMPLE

Y gl

hg\_l_l_l_l_l_l_l
<|

~ Custom Yiew Modifier Codes

[l | }|_

[

Code Value

Code Meaning

Cancel |

o]
—r |

[elete

i

(8] ¢

~Wiew Order
Fow | Column | Filmiew | Patient Orientation |
1 1 RCC Fogterior Left [P4L]
1 2 LCC Anterior Right [&4R]
1 3 RLO Fosterior Foot Left[...
2 1 LkLO Anterior Foot Right |...
2 2 Rkl Fosterior Foot [PYWF)
[T &rterior Foot [A5F)
RCCL A
LHCCL
RCChe
N LHCCM
\ [h
ExAMF—
w
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Establecimiento de campos de entrada de datos obligatorios

Los campos de entrada de datos de las ventanas Informacién del paciente
(Patient Information) e Informacion del estudio (Study Information) se
pueden establecer como obligatorios (lo cual se indica con los nombres en
negrita) conforme a las politicas de su organizacion.

Establezca los campos de datos obligatorios en la rama Local | Campos
obligatorios (Local | Mandatory Fields) del arbol de Administracion
(Administration).

Cx Administration L ] x|

B Local
i e Digplay Settings
Diigitizer Settings

td armmmography

: - License Backup
Targets
i Filen Drigitizer

Image Proceszing

— Mandatony Fields

Data entry fields in the Patient Information and Study [nfarmation windows can be designated as
mandatory [indicated in bold] in accordance with vour organization's policies.
Mate: All DICORM mandatary fields have been included by default.

Figlds | f andatony

Fatient Last Hame

Patignt Firzt Mame

Patignt Birth D ate

Accezzion Mumber

Referring Physician's Last Mame
Referring Physician's Firzt Mame
Study Description

Admitting Diagnosis Description
Series Description

Procedure Code Seguence
Body Part Examined

Seriez Date/Time

Protocol Harme

Perfarmed Protocal Code Sequence
Other Patient 1D

e e e e o o o e o o 3

Apply |

1. Establezca los campos obligatorios como corresponda:

m Para que el usuario tenga que rellenar un campo obligatoriamente:
marque la casilla de la columna Obligatorio (Mandatory).

m Para hacer que un campo sea opcional: desactive la casilla de la columna
Obligatorio (Mandatory).

2. Pulse el botdn Aplicar (Apply).
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Administracion de las cuentas de usuario

El Administrador de usuarios (User Manager) permite al administrador de
ClinicalExpress agregar, modificar y eliminar cuentas de usuario.

Nota: todos los usuarios de ClinicalExpress deben tener
asignados privilegios de usuario avanzado en Windows 2000 o
Windows XP.

Las cuentas de usuario se afiaden, editan o eliminan en la seccion Local |
Administrador de usuarios (Local | User Manager) de la ventana
Administracion (Administration). Las instrucciones comienzan en la pagina

siguiente.
x
- Local User Manager
- Dizplay Settings =
Digitizer Settings — Enrall Users, Change User Passwords and Remove Users
| P i
i il User Mame | Full Hame Description
td armmography e
M andatory Fields
e M anager
: Anonymize
i License Backup
- Targets
- Filmm Digitizer
1] |
Add Edit Hemove
Mote: &l ClinicalE spress users must be assigned Power User privileges under Windows 2000 and Windows <P,
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m Para afiadir una cuenta de usuario:

a. Pulse el botén Anadir (Add). Esto abre la ventana de Informacidn de
usuarios (User Information).

User Information

Uzer Mame: ||

Full M ame: |

Description: |

FPazzward: |

Confirn Passward: |

| Cancel |

b. Introduzca el Nombre de usuario (User Name) (es decir, el nombre de
inicio de sesion), el Nombre completo (Full Name) y la Descripcion
(Description) (p. €j., cargo) del nuevo usuario. Introduzca una Contrasefia
(Password) para el usuario, y vuelva a introducir la misma contrasefia en
el campo Confirmar contrasefia (Confirm Password).

c. Pulse Crear (Create).

m Para cambiar el nombre completo, la descripcion o la contrasefia de un
usuario:
a. En la lista de usuarios, pulse en la fila de la cuenta del usuario.

b. Pulse el boton Editar (Edit).

User Information

Uzer Mame: |

Full Mame:

Description: |F'rimary ClinizalE spress Operator

FPazzward: |

Confirn Passward: |

| Cancel

c. Cambie la informacién que corresponda.

d. Pulse Guardar (Save).
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Nota: el nombre de inicio de sesién (Nombre de usuario (User
Name)) del usuario no se puede cambiar. Para cambiar el
nombre de usuario, elimine la cuenta y cree una cuenta de
usuario nueva como se describe en este apartado.

Nota: la contrasefia del administrador se puede cambiar, pero
su nombre de usuario no. Guarde la contrasefia del
administrador en un lugar seguro.

m Para borrar una cuenta de usuario:

a. En la lista de usuarios, pulse en la fila de la cuenta del usuario.
b. Pulse el bot6n Borrar (Remove).

Nota: la cuenta de usuario “Admin” no se puede eliminar.

Las contrasefias no se pueden recuperar. Si un usuario olvida su contrasefia, hay
gue borrar su cuenta y crear una cuenta nueva para el usuario.
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Seleccion de los campos de datos para anonimizar

Cx Administration L x|

- Local

. e Display Settings

Digitizer Settings

Image Processing

td armmography

td andatory Fields

|Jzer Manager
orymize

3 Lizenze Backup

Targets

‘- Film Digitizes

Para preservar la intimidad del paciente, los datos de determinados campos se
pueden anonimizar (eliminar o sustituir por valores fijos) al enviar los estudios a
un destino. Al aplicar la anonimizacién durante la transmision, no se modifican
los datos originales guardados en la base de datos de ClinicalExpress.

El proceso de configuracion para anonimizar datos tiene dos pasos:

1. Especificar los campos que se van a anonimizar (descrito en este apartado).

2. Activar la opcion Anonimizar (Anonymize) para los destinos (descrito en el
siguiente apartado de este capitulo: “Definicion de destinos”).

Los campos andnimos se afiaden, modifican o eliminan en la seccion Local |
Anonimizar (Local | Anonymize) de la ventana Administracion
(Administration).

—Add Attributes to Anonymize Studies, Update Yalues and Femove Attibutes

Group | Element | Mame | Yalue ||

040010 DWD020  Patient ID
0:0008  O«0090  Refening Phyzician Hame
040008 00080 Institution Mame

1| |

Add Edit Remove
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m Para designar un campo como anénimo:

a. Pulse el botén Anadir (Add). Esto abre la ventana de Informacidn de
elementos del anonimizador (Anonymizer Element Information).

Anonymizer Element Information

Group: |I:I:<DD1 0 Element: |D>:EIEI1 1]
M ame: Patignt Marne
Lazt Marme: Firzt M arme: Middle M arne:
Walue: | |
Ol Cancel |

b. Abra la lista Nombre (Name) y haga clic en el campo que se va a
anonimizar. Puede anonimizar los siguientes campos:

e Nombre del paciente
(Patient Name)

e |D de paciente (Patient ID)

e Fecha de nacimiento
(Birth Date)

e Sexo del paciente
(Patient Sex)

e NUmero de registro
(Accession Number)

e Fecha del estudio
(Study Date)

e Hora del estudio
(Study Time)

e Descripcion del estudio

(Study Description)

e Descripcion de la serie

(Series Description)

Descripcion del diagnostico en
admision (Admitting Diagnosis
Description)

Nombre del médico remitente
(Referring Physician Name)
Nombre del centro

(Institution Name)

Modalidad (Modality)
Fabricante (Manufacturer)

ID de estudio (Study ID)
Numero de serie (Series Number)
NuUmero de instancia

(Instance Number)

Tipo de conversion
(Conversion Type)

Parte del cuerpo examinada
(Body Part Examined)

c. Opcional: introduzca un Valor (Value) para reemplazar los datos del
paciente. Si no se introduce ningun valor, el campo anénimo se deja

en blanco.

d. Pulse Aceptar (OK).

m Para editar los valores de anonimizacion de un campo:

a. Pulse en la fila del campo que se va a modificar.

b. Pulse el boton Editar (Edit).
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c. Cambie el Valor (Value) en la ventana de Informacion de elementos del
anonimizador (Anonymizer Element Information).

d. Pulse Aceptar (OK).

m Para borrar la anonimizacion de un campo:
a. Pulse en la fila que se va a borrar.

b. Pulse el boton Borrar (Remove).
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Copia de seguridad y restablecimiento de la licencia

Cx Administration A x|

[=l- Local
; - Dizplay Settings

e Digitizer Settings

- Image Processing

- Mammagraphy

- Mandatory Fields

- Uzer b anager

e ROz E

i .. License Backup

- Tangets

"~ Film Digitizer

Las instalaciones de ClinicalExpress tienen la opcion de hacer una copia de
seguridad de la licencia. Se recomienda configurar esta funcién poco después de
instalar ClinicalExpress, ya que permite guardar la clave de licencia en un lugar
seguro, como por ejemplo un directorio de red o un lapiz de memoria (memoria
USB), para poder restaurar la licencia en el caso de que se produjera un problema
de hardware o software en el ordenador.

El archivo de copia de seguridad de la licencia registra el niUmero de escaneados
que quedan y el limite de tiempo de la licencia. Este archivo se vuelve a crear
con los datos del ultimo escaneado y la hora cada 24 horas sobrescribiendo la
copia anterior (por ese motivo no se puede hacer la copia de seguridad en un CD
o un DVD). Si ClinicalExpress no esta funcionando a la hora programada de una
copia de seguridad, la copia se realiza la siguiente vez que se inicia la aplicacion.

Copia de seguridad de la licencia

Haga una copia de seguridad de la licencia en la seccion Local | Copia de
seguridad de la licencia (Local | License Backup) de la ventana de
Administracion (Administration).

- License Backup

[ Enable License Backup

Backup Folder:

| o]

Backup License

m Para hacer una copia de seguridad de la licencia:

a. Active la opcién Habilitar copia de seguridad de la licencia (Enable
License Backup).

b. Pulse el boton Méas (More) _| y seleccione la ubicacién donde desea
guardar la licencia.

Nota: no seleccione una ubicacién del ordenador local.
Seleccione un directorio de red, un lapiz de memoria que esté
siempre conectado al ordenador o una ubicacién similar que no
se vea afectada si el ordenador local tiene algin problema o es
necesario cambiarlo.

c. Pulse el boton Copia de seguridad de la licencia (Backup License).
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Restaurar la licencia

Si hay algun problema de hardware o software en el ordenador donde se ejecuta
ClinicalExpress, y se ha activado la opcién de copia de seguridad de la licencia
(descrita en la pagina anterior), VIDAR puede restaurar la licencia.

1.

2.

Cree un mensaje de correo electrénico nuevo.
En el campo Para del mensaje, escriba medtech@vidar .com.

Localice el archivo de copia de seguridad de la licencia (tendra la extension
.ref) y adjuntelo al mensaje.

. En el cuerpo del mensaje, describa la situacion y solicite el restablecimiento

de la licencia.
Envie el mensaje.
Cuando reciba la respuesta con la licencia restaurada, instale la licencia como

se describe en el paso 2 del apartado “E. Obtener una clave de licencia de
ClinicalExpress” del capitulo “Instalacion de ClinicalExpress” de este manual.

Si no puede proporcionar una copia de la licencia, tendra que adquirir una
licencia nueva.
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Definicion de destinos

Los administradores pueden configurar, modificar y eliminar parametros de
destinos y dispositivos remotos. Un destino es un punto al que se envian estudios
0 un punto de origen de datos de Listas de trabajo de modalidad (la opcién de
Lista de trabajo de modalidad se adquiere por separado).

Los destinos se gestionan en la rama Destinos (Targets) del arbol de
Administracion (Administration).

Cx Administration .. x|

- Local

P Dizplay Settings
Digitizer Settings —Set Up, Edit and Delete Parameters for Targets and Remote Devices
Image Processing
t armrmography

t andatory Fields
|Jzer Manager
Anonymize
Lizensze Backup

MHame | Type | Description

DICDM-F'FHNT. S Ileth F‘rintern o

DICOM Store
DICOM PRINT
- Film Drigitizer

Mew Edit Delete
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Creacion de un nuevo destino

1. Pulse el boton Nuevo (New). Esto despliega la pagina Nuevo destino
(New Target).

Target Canfiguration

Mame: | [ LuT

UL DTN S TORE |

Desc.: | [ Storage Commitment

I~ Default T arget: | J

[ Anonymize

[ Allow Lossless Compression Maimum Wait Time: | minute(s)

Communication

AE Tith: r
PDU Size: lose
Fiesponze Timaot: ID—
Port Mumber: ID—
Haost M ame: l—

I Dialup

Prefix: l—
Phone Mumber: l—
Diamain; l—
UserMame: l—
Password; l—

Digitizer

[ Set Film Size Based Resolution

[ Enable Bit Depth and Resolution

Bit Depth: Rezolution:

Cancel Sawe

2. En la seccion Destino (Target):

Target

Mame: |

LET 0N S TORE
Desc.: |

[ Default

[ Anorymize

[ Allows Lossless Compression
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. Introduzca el Nombre (Name) del destino. Conviene que sea un nombre

claro y conciso, como por ejemplo “Clinica” o “Dra. Rol”. Use nombres
que los usuarios no puedan confundir.

Nota: después de introducir el nombre y guardar el destino, el
nombre ya no se puede cambiar. Para cambiar el nombre es
necesario eliminar el destino y crear uno nuevo.

. Seleccione el Tipo (Type) de destino. Las opciones son:

= ALMACENAMIENTO DICOM (DICOM STORE)

= COMPROMISO DE ALMACENAMIENTO (STORAGE
COMMITMENT)

= PASO DE PROCEDIMIENTO REALIZADO EN MODALIDAD

(MODALITY PERFORMED PROCEDURE STEP)

IMPRESORA DICOM (DICOM PRINTER)

IMPRESORA POSTSCRIPT (POSTSCRIPT PRINTER)

CD DICOM (DICOM CD)

LISTA DE TRABAJO DE MODALIDAD (MODALITY WORK LIST)

CONSULTA DE PACIENTES DICOM (DICOM PATIENT QUERY)

Nota: el campo Tipo (Type) determina los campos que se
pueden cambiar en las secciones de la izquierda de la ventana
Nuevo destino (New Target), asi como los campos que
aparecen en la seccién de la derecha (Configuracién
(Configuration)).

. (Opcional) Introduzca una Descripcion para el destino.

. Para designar este destino como el predeterminado: margue la opcién

Predeterminado (Default). La informacion del destino predeterminado se
indica en la seccion Destino (Target) de la ventana principal de
ClinicalExpress cuando se inicia el programa y cuando el usuario pulsa el
botén Destino predeterminado (Default Target).

Sugerencia: sila estaciéon de trabajo va a enviar estudios a un
Unico destino o al mismo destino la mayoria de las veces,
configure ese destino como predeterminado.

. Para anonimizar los datos enviados a este destino: marque la opcién

Anonimizar (Anonymize). Los campos para anonimizar se seleccionan en
la ventana Local | Anonimizar (Local | Anonymize) (consulte el apartado
anterior de este capitulo: “Seleccion de los campos de datos para
anonimizar”).

. Para permitir la compresion sin pérdida JPEG estandar: marque la casilla

Permitir compresion sin pérdida (Allow Lossless Compression).
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3. En la seccion Comunicacion (Communication):

Communication

AE Title: r
PDU Size: ,4055—
Fesponse Timeout: ,D—
Part Nuriber: ,EI—
Host Mame: l—

[~ Dialup
Prefis: l—
Phane Murnber: l—
Domain: l—
LserMame: l—
Paszword: l—

a. Introduzca el Titulo EA (AE Title) (titulo de la entidad de aplicacion) del
destino remoto. En los Titulos EA se distingue entre mayUsculas y
minusculas.

b. Introduzca el Tamarfio de PDU (PDU Size) (tamafio de la unidad de datos
de protocolo) del destino en bytes. Este parametro especifica el tamafio de
bloque méaximo que el destino puede recibir de ClinicalExpress.

Nota: los parametros Titulo EA (AE Title) y Tamafio de PDU
(PDU Size) normalmente los define el programa receptor.

c. Introduzca el Tiempo de espera de respuesta (Response Timeout)
necesario en minutos. Este es el periodo de tiempo que ClinicalExpress
espera por una respuesta después de enviar una comunicacion al destino.
Un trafico de red intenso ralentiza el funcionamiento de ClinicalExpress.
El valor maximo es de 5 minutos. Para especificar un tiempo de espera
infinito, introduzca el valor 0.

d. Introduzca el nimero de Puerto (Port) de la aplicacion receptora (p. €j.,
104, 4006).

e. Introduzca el Nombre de host (Host Name) o la direccion IP de la
aplicacién receptora.

f. Sise va a acceder al destino a través de una conexion de acceso telefénico,
marque la casilla Acceso telefénico (Dial-up), e introduzca la informacion
correspondiente.
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4. Laseccion Digitalizador (Digitizer) permite configurar la profundidad en bits
y la resolucién predeterminadas, y especificar si los usuarios pueden
reemplazar estos valores predeterminados. La Profundidad en bits (Bit
Depth) predeterminada es 16, y la Resolucion (Resolution) predeterminada
es 570. En la seccion Digitalizador (Digitizer):

Diigitizer
I Set Film Size Bazed Resolution
™ Enable Bit Depth and Resolution

Bit Depth: Rezalution:

a. Para permitir establecer la resolucion en funcion del tamafio de la
radiografia: margue la opcidén Resolucion definida por la radiografia
(Set Film Size Based Resolution).

b. Para cambiar la profundidad en bits y la resolucién predeterminadas:
marque la opcion Habilitar profundidad en bits y resolucién (Enable
Bit Depth and Resolution) e introduzca los valores de Profundidad en
bits (Bit Depth) y Resolucidn (Resolution) correspondientes. (Los valores
disponibles dependen del digitalizador conectado.)

c. Para permitir que los usuarios reemplacen la profundidad en bits y la
resolucion predeterminadas: active (o deje activada) la opcion Habilitar
profundidad en bits y resolucion (Enable Bit Depth and Resolution).
Consideraciones:

m Desactive la opcion Habilitar profundidad en bits y resolucion
(Enable Bit Depth and Resolution) si el destino tiene que recibir las
imégenes capturadas con una profundidad en bits y una resolucién
especificas. Esta es la configuracion recomendada si no se esta usando
la opcidn de Resolucién definida por la radiografia (Set Film Size
Based Resolution).

m Active la opcion Habilitar profundidad en bits y resolucion (Enable
Bit Depth and Resolution) si el destino puede recibir imagenes
capturadas con cualquier profundidad en bits y resolucion disponibles, y
los usuarios de ClinicalExpress tienen la formacion necesaria para
seleccionar los ajustes apropiados para el estudio y el destino.

Nota: es responsabilidad del centro asegurarse de que la
profundidad en bits y la resolucién de las imagenes y estudios
con los que se va a utilizar ClinicalExpress son clinicamente
adecuadas.
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5. Las opciones de la seccion Configuracion (Configuration) dependen del
Tipo (Type) de destino seleccionado. Siga las instrucciones para el Tipo
(Type) de destino seleccionado:

m Parael Tipo (Type) de destino ALMACENAMIENTO DICOM (DICOM
STORE):

Canfiguration

[ LT
|

[ Storage Commitment

T arget: | J

b amirmum ' ait Time: | rirute(s]

a. Si hay una tabla de busqueda disponible para el destino, marque la
casilla TB (LUT) y pulse el boton ... (indicado por la flecha) para
seleccionar el archivo de TB.

b. Si ClinicalExpress tiene que responder a los mensajes de compromiso

de almacenamiento de un destino:

e Active la casilla Compromiso de almacenamiento (Storage
Commitment).

e Seleccione un Destino (Target), o bien Mismo (Same) para aplicar
esta opcion al destino actual.

e Introduzca un Tiempo de espera maximo (Maximum Wait Time).
ClinicalExpress no hard nada salvo que reciba un compromiso de
almacenamiento dentro de este periodo de tiempo.

m Parael Tipo (Type) de destino COMPROMISO DE
ALMACENAMIENTO (STORAGE COMMITMENT):

Configuration
Storage Commitment

b amimnunn e ait Time: |':' riirke]z)

Introduzca un Tiempo de espera maximo (Maximum Wait Time).
ClinicalExpress no hara nada salvo que reciba un compromiso de
almacenamiento dentro de este periodo de tiempo.

m Parael Tipo (Type) de destino PASO DE PROCEDIMIENTO
REALIZADO EN MODALIDAD (MODALITY PERFORMED
PROCEDURE STEP), no hay opciones de configuracion.
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m Parael Tipo (Type) de destino IMPRESORA DICOM (DICOM
PRINTER):

Configuration
Settings

Magnification: [REPLICATE w| | TrueSize

Filrm Orientation: |PORTRAIT Printable Area:

Media: ,W‘ 14471916,2520
Film Size: ,W‘
Didir: lui
Dbz o

[ LT /

¥ Apply SDF

Printer Type Tranzformation Type

e liansmissive ~ SCF - Create LUT and send to
[Filrn) printer for applying
Raflective (e SEU - Create LUT and apply on
[Paper) image before sending to printer

[~ Apply SDF onimage even i not supported by the printer

Illurnination: 2000.000 cd! w2
Armnbignt Light: 10,000 cdd m2

a. Si hay una tabla de busqueda disponible para la impresora, active la
casilla TB (LUT) y pulse después el boto6n ... (indicado por la flecha)
para seleccionar el archivo de la TB. Las TB disponibles estan en el
directorio especifico de las impresoras del CD de instalacion de
ClinicalExpress.

b. Si no hay una tabla de busqueda disponible para la impresora, active la
casilla Aplicar FVE (Apply SDF) (funcién de visualizacion estandar)
Yy, a continuacion:

Configure el Tipo de impresora (Printer Type) para que coincida
con la impresora DICOM.

Establezca el Tipo de transformacion (Transformation Type) en
SCP (la impresora aplica la FVE a la imagen) o en SCU
(ClinicalExpress aplica la FVE a la imagen). Para que el Tipo de
transformacion (Transformation Type) sea vélido, la impresora
DICOM debe ser compatible con la clase de SOP de la TB de
presentacion (compruebe los detalles en el manual de la impresora);
esto lo negocia el software durante la fase de asociacion.

Si se activa la casilla Aplicar FVE a la imagen aunque sea
incompatible con la impresora (Apply SDF on image even if not
supported by printer), y la impresora no admite la clase SOP de
presentacion (compruebe el manual de la impresora),
ClinicalExpress genera los valores de la FVE (basandose en los
campos lHuminacion (Illumination) y Luz ambiental (Ambient
Light)) y aplica una TB antes de enviarla a la impresora.
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Introduzca los valores de IHluminacion (Illumination) (luminancia
debida a la iluminacion) y Luz ambiental (Ambient Light)
(luminancia debida a la luz ambiental) para usar en el calculo de la
FVE. Los valores predeterminados de DICOM son:

Medio de transmision  Medio de reflexién

(pelicula) (papel)
lluminacién 2000 cd/m? 150 cd/m?
Luz ambiental 10 cd/m? 0 cd/m?

c. En laseccion Configuracion (Settings):

Ajuste la Ampliacién (Magnification) como corresponda. Las

opciones son:

¢ Réplica (Replicate) (cada pixel de la impresora representa un
pixel de la imagen).

¢ Ninguna (None) (ajusta la imagen al tamafio medio de la
impresora sin volver a interpolar).

+ Bilineal (Bilinear) (ajusta la imagen al tamafio medio de la
impresora usando una interpolacion bilineal).

¢ Cubica (Cubic) (ajusta la imagen al tamafio medio de la
impresora usando una interpolacion cubica).

Establezca la Orientacion de la radiografia (Film Orientation) en

Vertical (Portrait) (borde mas largo en vertical) u Horizontal

(Landscape) (borde mas largo en horizontal).

Seleccione el medio del destino: Pelicula azul (Blue Film), Pelicula

transparente (Clear Film) o Papel (Paper).

Ajuste el Tamafio de la radiografia (Film Size) en pulgadas.

Ajuste los valores de DMin (opacidad minima de la pelicula) y

DMax (opacidad méaxima de la pelicula).

Active la opcién Tamafio real (True Size) para imprimir con la

misma relacion de aspecto de la radiografia original. Si no se activa

esta opcion, la relacion de aspecto de la imagen se modifica para

ajustarla al area de impresian.

Area de impresion (Printable Area) especifica como recortar la

imagen si el tamafio de impresion solicitado es mayor que el area de

impresion de la impresora.
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Mas sobre el area de impresion

Un duplicado de una radiografia suele tener un area de impresién menor que la radiografia original del
mismo tamafio total.

m Al imprimir una imagen en un medio del mismo tamafio que la radiografia original, es de esperar
gue se produzca una cierta reduccion o recorte (dependiendo de los ajustes de la seccion
Configuracion (Configuration) de la IMPRESORA DICOM de destino y de las opciones
disponibles que proporcionen el servidor y la impresora).

m Cuando se imprime una imagen mas pequefia que el area de impresion de la impresora (que suele
ser de 14 pulgadas x 17 pulgadas), la imagen resultante tiene el mismo tamafio que el original.

Ejemplo: supongamos que el area de impresion es de 13,5 pulgadas x 16,5 pulgadas y que la
resolucion es de 150 pixeles por pulgada. El Area de impresion (Printable Area) seria:

14X17:2025,2475
donde 14X17: es el tamafio de la radiografia original (debe incluir la “X” mayuscula)
2025 es la anchura del area de impresion en pixeles (13,5 pulgadas x 150 pixeles por pulgada)
2475 es la longitud del area de impresion en pixeles (16,5 pulgadas x 150 pixeles por pulgada)

m Parael Tipo (Type) de destino IMPRESORA POSTSCRIPT
(POSTSCRIPT PRINTER):

Caonfiguration

[ Wt
| f

Settings

a. Si hay una tabla de busqueda disponible para el destino, marque la
casilla TB (LUT) y pulse el botdn ... (indicado por la flecha) para
seleccionar el archivo de TB. Las TB disponibles estan en el directorio
especifico de las impresoras del CD de instalacion de ClinicalExpress.

b. Haga clic en Configuracién (Settings) para abrir la ventana
Configurar impresion (Print Setup) estandar. En esta ventana se
puede seleccionar una impresora y cambiar sus propiedades.

Nota: para poder usar este tipo de destino es necesario instalar
controladores de impresora postscript. Consulte la informacion
de los controladores en el manual de la impresora.
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m Parael Tipo (Type) de destino CD DICOM (DICOM CD):

Caonfiguration
DICOM CD

Copies; 1 -
Drrivves; R -

a. Especifique el nimero de Copias (Copies) que se van a crear.

b. Seleccione la Unidad (Drive) de CD.

m Parael Tipo (Type) de destino LISTA DE TRABAJO DE MODALIDAD
(MODALITY WORK LIST):

Configuration
tapping of Woarklist Query Results
[ Use Only Patient Information
[~ Enable Broad Query
[ Scheduled Procedure Step Start Date To Study Date
[~ Requested Procedurs 1D To Study (D

a. Active la casilla Usar solo informacion del paciente (Use Only
Patient Information) para importar solamente informacion basica del
paciente de una consulta de Lista de trabajo de modalidad.

b. Active la opcion Habilitar consulta extendida (Enable Broad Query)
si el sistema puede acceder a multiples listas de trabajo de modalidad y
si desea que el usuario pueda buscar todas las MWL con una Unica
consulta.

c. Active la opcion Usar fecha programada del paso del procedimiento
como fecha del estudio (Scheduled Procedure Step Start Date to
Study Date) para asignar la fecha del procedimiento a la fecha del
estudio al crear una nueva cuenta de paciente consultando el servidor de
MWL.

d. Active la opcion Usar ID de procedimiento solicitado como ID de
estudio (Requested Procedure ID to Study ID) para asignar la ID de
un procedimiento solicitado a la ID de un estudio.

m Parael Tipo (Type) de destino CONSULTA DE PACIENTES DICOM
(DICOM PATIENT QUERY), no hay opciones de configuracion.

6. Cuando haya introducido toda la informacién del destino, pulse el boton
Guardar (Save). El nuevo destino aparece en la seccion Destinos (Targets)
de la ventana Administracion (Administration).
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Gestion de lainformaciéon de los destinos

m Para obtener una lista de los destinos existentes: haga clic en Destinos
(Targets) en el arbol de administracion.

X Administration

+- Local
DICOM Store Set Up, Edit and Delete Parameters for Targets and Remote Devices
DICOM Printer —
PoztScript Prinker Name Type Decription
Film Digitizer . -
Faper Document Scanner DICOmM .F'nntn.al DICOM lF'nnh?r
PogtS cript Printer FostSeript Printer

m Para ver la configuracién de un destino: haga clic en el nombre del destino
debajo de Destinos (Targets) en el arbol de administracion.
m Para editar la informacion de un destino:
a. Haga clic en el nombre del destino debajo de Destinos (Targets) en el
arbol de administracion.
0
Haga clic en el nombre del destino en la lista resumida de destinos.

b. Pulse el boton Editar (Edit). Los campos se habilitan y se pueden editar.

c. Cuando haya terminado, pulse el boton Guardar (Save).

m Para eliminar un destino:

a. Haga clic en el nombre del destino debajo de Destinos (Targets) en el
arbol de administracion.
0
Haga clic en el nombre del destino en la lista resumida de destinos.

b. Pulse el boton Eliminar (Delete).
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Comprobacién de la comunicacion

Después de definir un destino es aconsejable comprobar la comunicacién entre
ClinicalExpress y el destino o el agente de MWL (la opcion MWL de
ClinicalExpress se puede adquirir por separado). Por supuesto, también se puede
comprobar en cualquier otro momento.

1. En la ventana principal de ClinicalExpress, seleccione Archivo > Generar
carta de ajuste > SMPTE (File > Generate Test Pattern > SMPTE). Esta
opcion utiliza un estudio especial adquirido que se usa estrictamente para
efectuar ajustes.

2. Abra la lista Destino (Target) y haga clic en el destino que se va a comprobar.

3. En la seccion Destino (Target), pulse el boton Verificar (Verify) (justo
debajo de la lista desplegable de destinos).

4. Espere a que ClinicalExpress responda. Se obtendra uno de los dos mensajes
siguientes:

m “Destino — [nombre del destino]. Solicitud de verificacién correcta”
(“Target — [target name]. Verification request succeeded.”) indica que el
destino ha respondido correctamente al comando Eco DICOM de
ClinicalExpress.

m “Destino — [nombre del destino]. Solicitud de verificacién incorrecta”
(“Target — [target name]. Verification request failed.”) significa que el
destino no ha respondido al comando Eco. Si ve este mensaje, compruebe
los detalles de la configuracion del destino en ClinicalExpress y asegurese
de que la red funciona correctamente.

Repaso de la configuracion del digitalizador de radiografias

X Administration

—I- Local
Dizplay Settings
Image Processing
Image Enhancement
M ammography
M andatory Fields
Uszer Manager
Anongmize

+- Targets

Consulte la configuracion del digitalizador en la rama Digitalizador (Digitizer)
del &rbol de Administracién (Administration).

3

Film Digitizer

Film Drigitizer Configuration

Froperty Yalue
Digitizer 1D 1
Digitizer Serial Mumber |
Digitizer Hardware “ersion 2
Digitizer Firnnware Werzion 4
Digitizer A Size 1024
SCSI 1D 1
SC51 Wergion 1
Supported Bits Per Pixel 8.12,16
Supported Resolutions B0, 71, 75,100,142
Core Pagaword EJEWHLMM
Extended Password DL
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Comprobacién de la disponibilidad de listas de trabajo de

modalidad

Nota: la opcién de Lista de trabajo de modalidad de
ClinicalExpress se puede adquirir por separado. Para que esta
funcién esté disponible, su copia de ClinicalExpress debe tener
la licencia para la Lista de trabajo de modalidad.

Nota: las instrucciones de este apartado asumen que el
administrador ha seguido las instrucciones para crear un nuevo
destino de Lista de trabajo de modalidad (consulte el apartado
“Definicion de destinos” anterior en este mismo capitulo).

m Para determinar si la opcidn de Lista de trabajo de modalidad esta instalada:

a. En la ventana principal, seleccione, Ver > Estudios adquiridos (View >
Acquired Studies).

b. En la ventana Informacién de estudios (Studies Information),
compruebe la lista Destinos (Targets):

e Si hay al menos un destino en la lista, la opcion de Lista de trabajo de
modalidad esté instalada y ya se ha configurado para un destino de Lista
de trabajo de modalidad.

e Silalista esta vacia, la opcién de Lista de trabajo de modalidad no esta
instalada.

c. Enlaventana Informacién de estudios (Studies Information), pulse
Cerrar (Close).

Para comprobar si la estacion de trabajo de ClinicalExpress estd conectada a
un origen de Listas de trabajo de modalidad:

a. En la ventana principal, abra la lista de Destinos (Targets) y haga clic en
un destino de Lista de trabajo de modalidad.

| [ Modaliy work List - =l
| Werify |

b. Pulse Verificar (\Verify).

c. Aparece un mensaje que indica si la conexidn esta funcionando.

Nota: para ver instrucciones detalladas del uso de la Lista de
trabajo de modalidad, véase el apartado “Importar los datos de
un paciente usando la lista de trabajo de modalidad” de la “Guia
del usuario de ClinicalExpress”.
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Revision y gestion del archivo de registro

El archivo de registro, un archivo de texto que se guarda en el directorio del
programa, contiene un registro de las acciones realizadas por ClinicalExpress.
Use el archivo de registro para revisar y analizar las actividades de los usuarios y
del programa a los efectos de solucionar problemas. ClinicalExpress incluye una
ventana para consultar y administrar el archivo de registro.

| Date/Time | Severiy | Descripion |
??%i%guim Infarmation [Clinical Express Launched
??féi%gnim Infarrmation [User Admin logged in.
??féifégnim Infarmation  [Initializing Film Digitizer. ..
??féifégnim Infarmation  |[Film Digitizer error 1793,
??féi%gnim Infarmation  [Initialized network for storage commitment event reports receiving.
??féi?gnim Infarmation [Hot key combinations were disabled.
ggg?figuﬁm Infarmation Hot key combinations were enabled.
gj%g%?ugm Infarmation Target Dicom Store of type DICOM Store created.
gjg?ggugm Infarmation Target Modality Work List of type Modality Work List created.
Clear Log | | Refresh | |

m Para ver el archivo de registro: seleccione Ver > Archivo de registro (View
> Log File).

m Para borrar los datos del archivo de registro: pulse el boton Borrar registro
(Clear Log).

m Para incorporar nuevos datos al archivo de registro: pulse el boton Renovar
(Refresh).

Nota: configure las opciones del registro en la pagina de
administracion Local (consulte “Registro” en el apartado
“Configuracion de los parametros de la estacion de trabajo
local” anterior en este mismo capitulo).
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Calibracion del digitalizador de imagenes

Calibre el digitalizador de radiografias siguiendo las recomendaciones que
figuran en el manual de funcionamiento del digitalizador.

Nota: la calibracion tarda varios minutos, durante los cuales no
se podra utilizar el digitalizador ni ClinicalExpress.

m Para calibrar el digitalizador:
a. Seleccione Opciones > Calibrar escaner (Options > Calibrate Scanner).

b. Confirme que desea iniciar la calibracion.

Clinical Express

2 Calibrating Digitizer: This will take about 2 to 3 minutes,
‘“-‘.',-"" Do yiou wankt ko continue?

c. Espere a que el digitalizador de radiografias se calibre.

CALIBRATIOM IN PROGRESS

d. Cuando haya concluido la calibracion, pulse Si (Yes).

Clinical Express

\!.J) Digitizer calibration successkul,
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Calibracion de la pantalla

Para que la calidad de la imagen sea buena es importante que se presente en
pantalla correctamente. Si la pantalla presenta la imagen con exactitud, el usuario
puede evaluar eficazmente la calidad de la imagen y optimizarla correctamente.
Aunque la pelicula se haya digitalizado correctamente, en una pantalla sin
calibrar puede parecer que la imagen es de mala calidad. En este apartado se
explican dos métodos para calibrar facilmente la pantalla.

Ponga en conocimiento del fisico médico encargado del control de calidad de las
pantallas los problemas de presentacion grafica. Los problemas de pantalla deben
someterse a una investigacion exhaustiva y, en funcidn de los resultados, se debe
reajustar, realizar un mantenimiento, reparar o cambiar el aparato.

Para una calibracion més rigurosa de la pantalla, VIDAR recomienda utilizar
productos VeriLUM, disponibles a través de:

IMAGE Smiths, Inc.
P.O. Box 30928
Bethesda, MD 20824 EE. UU.

Teléfono: +1 (240) 395-1600
Pagina web: www.image-smiths.com
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Calibracion con la carta de ajuste de la SMPTE

1. Seleccione Archivo > Generar carta de ajuste > SMPTE (File > Generate
Test Pattern > SMPTE) para abrir la imagen de la carta de ajuste de la
SMPTE (representada mas abajo).

2. Ajuste al minimo los controles de brillo y contraste de la pantalla.

3. Aumente el brillo hasta que consiga ver las barras de las esquinas.

4. Aumente el contraste hasta aproximadamente el 80% o mas, hasta que pueda

ver los cuadrados del 0%/5% y 95%/100% de la imagen lo mas claramente
posible.

AN

Cuadrado del 0%/5% Cuadrado del 95%/100%

Nota: si esta viendo una copia electrénica de este documento
en una pantalla y no puede distinguir el cuadrado del 0%/5% o
el cuadrado del 95%/100% de esta pagina (indicados por las
flechas), entonces es necesario calibrar la pantalla.
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Calibracion con la carta de ajuste TG18-QG

1. Seleccione Archivo > Generar carta de ajuste > TG18-QC (File > Generate
Test Pattern > TG18-QC) para abrir la imagen de la carta de ajuste TG18-QC
(representada mas abajo).

QUALITY
CONTROL

2. Examine visualmente las siguientes caracteristicas:

a. Distorsion geométrica: compruebe que los bordes y las lineas de la carta se
pueden distinguir y son rectos, y que la carta esta centrada en el area activa
del dispositivo de pantalla.

b. Calidad general de la imagen y artefactos: evalGe el aspecto general de la
carta. Compruebe que no haya pérdidas de la uniformidad ni artefactos,
especialmente en los cambios de negro a blanco y de blanco a negro.
Compruebe que las areas de degradado son continuas y no presentan
artefactos de contorno.
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c. Luminancia, reflexion y ruido: compruebe que se pueden distinguir
claramente las 16 zonas de luminancia. Compruebe que se pueden
distinguir las zonas del 5% y el 95%. Evalue la apariencia de las letras de
bajo contraste y confirme la visibilidad de los elementos de las esquinas de
todas las zonas de luminancia.

d. Resolucion: evalue la apariencia de los elementos Cx del centro y las
esquinas de la carta, y asigneles puntuaciones en comparacion con la
referencia. Las puntuaciones deben ser inferiores a 5 para los monitores
primarios e inferiores a 7 para los secundarios. Compruebe también la
visibilidad a la frecuencia de Nyquist de las rejillas del centro y las
esquinas de la carta.”

Contacte con el Servicio Técnico de VIDAR si tiene cualquier
duda sobre la configuracion del software ClinicalExpress:

Teléfono: +1 800 471 SCAN (+1 800 471 7226)
+1 703 471 7070 fuera de EE. UU.
Correo electronico: medtech@vidar.com

“ Los pasos 2a a 2d han sido reproducidos con la debida autorizacién de “New
Developments in Display Quality Control,” por Ehsan Samei, en Quality Assurance and
Quality Control in the Digital Imaging Department, Eds. E. Siegel, B. Reiner, J. Carrino,
SCAR Premier Series, Society for Computer Applications in Radiology, Great Falls, VA,
2002, pp. 71-82.
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